
C U S T O M I Z I N G  P E R F O R M A X 3  C O U R S E W A R E  
U S I N G  A U T H O R M A X  

 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

AuthorMax Orientation Package 

 
 
 
 
 
 
2555 Enterprise Rd. 
Suite 8 
Clearwater, FL 33763 
1‐888‐752‐6299 
www.performax3.com 

 1



C U S T O M I Z I N G  P E R F O R M A X 3  C O U R S E W A R E  
U S I N G  A U T H O R M A X  

Notes: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

What is AuthorMax? 
 

A Powerful and Ve satile 
Authoring Tool 

r

As a customer-focused company, PerforMax3 allows our healthcare 
customers to modify the courses and lessons provided. AuthorMax is a 
COTS product developed, distributed and maintained by PerforMax3 
for commercial and government customers.  Specifically, for the 
Defense Health Services Systems (DHSS), PerforMax3 is delivering 
105 licenses of AuthorMax, our SCORM 2004 (and SCORM 1.2) 
conformant authoring tool that will enable 210 content authors within 
the DoD/MHS and VA to create and/or customize web-based training 
content that complies with the requirements of the Section 508 
amendment to the Rehabilitation Act of 1973. 
 
The AuthorMax authoring tool is fully compatible with the 40 COTS 
courses delivered on June 11, 2009.   The authoring tool enables 
student authors to tailor or customize the COTS courseware through 
access to the source code packaged as part of the Courseware 
deliverable. The authoring tool is ideally suited to embedding site-
specific training requirements, references and enclosures into the 
COTS Courseware.  Using the templates provided and the COTS 
Courseware itself, content authors are also able to create new training 
material. 
 
The maintenance plan for AuthorMax and for the COTS Courseware 
is integrated to ensure compatibility throughout the term of this 
activity. 
 
Authoring Tool Licensing 
The AuthorMax content authoring tool is offered as a Perpetual 
License.  A quantity of 105 AuthorMax licenses is included within the 
scope of the delivery for 210 content authors.  Maintenance for the 
authoring tool is defined in the maintenance program paragraphs 
below and is offered as part of the AuthorMax license at no cost to the 
government for a term of 24 months. 
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Notes: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Authoring Tool Delivery  
PerforMax3 will deliver the AuthorMax authoring tool licenses and 
associated material and instructions to the contracting agency (DHHS) 
within 30 days of award, for distribution among the participating agencies 
within the DoD/MHS and the VA.  The entire AuthorMax offering will be 
delivered in electronic form from a PerforMax3 website.  The installation of 
the product requires the registration of each “seat” where the licensed user 
provides name and organization and enters a serial numbers as an activation 
code.  The distribution of the 105 AuthorMax licenses among the 
participating agencies is the responsibility of the contracting agency or their 
designee within the DoD/MHS and VA. 
 
The customer will identify a Point of Contact for the delivery of the 
AuthorMax authoring licenses and material for the coordination of the 
assigned serial numbers and for the scheduling and registration of student 
authors for training. 
 
 
Authoring Tool Components 

AuthorMax, the PerforMax3 authoring tool, was released in 2003 to support 
the “open source” version of our courseware released the same year.  The 
AuthorMax offering is an all inclusive package consisting of the following 
four (4) elements: 

• ToolBook Instructor version 9.5 (2 seats) 
• AuthorMax Template 
• AuthorMax Training 
• AuthorMax Maintenance 
• FTP Site Containing 40 COTS courses 

 
 

ToolBook Instructor 

PerforMax3 has been using ToolBook Instructor internally to create 
courseware since our initial courseware release in 1997.  We’ve 
standardized on ToolBook because of its functionality, reputation and 
interoperability with a host of LMS applications. ToolBook support the 
PerforMax3 Rapid Courseware Deployment methodology.  ToolBook is 
produced by SumTotal Systems, Inc. (NASDAQ: SUMT) and global 
provider of talent development solutions.   
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The ToolBook Instructor product is a widely used, award winning 
application for the creation, development and delivery of interactive content, 
quizzes, assessments, and software application simulations.   ToolBook 
enables content authors to create Section 508, and ADL SCORM 
conforming Web content that runs well stand-alone or within standards 
based LMS platforms. ToolBook enables training organizations to deliver 
engaging learning experiences to users using their desktop PC, Web browser 
or even mobile devices. 

Notes: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Each AuthorMax license offered to the DoD/MHS and VA under this 
contract includes two licenses for ToolBook Instructor 9.5 product produced 
by SumTotal Systems, Inc. ToolBook is licensed by the seat/user, one seat 
or user per ToolBook license such that each AuthorMax license accounts for 
2 authorized seats or users.  By extension, 105 AuthorMax licenses 
accommodate 210 content authors within the DoD/MHS and VA. 
 

AuthorMax Template 

The AuthorMax template and associated training are central to our “Rapid 
Courseware Deployment” methodology.  This methodology is used for the 
maintenance and customization of PerforMax3 courseware and the 
development of new topics using the instructional design model, content 
organization, style guide and learning objects to create.  By using the 
template and the development techniques and skill set taught in our training 
series, our client-authors create training material that is consistent with our 
healthcare courseware, familiar to the student-user community and benefits 
from the SCORM and section 508 accessibility design details incorporated 
in the template. 
 
PerforMax3 staff developers also use the AuthorMax template and Rapid 
Courseware Deployment methodology internally as the starting point for 
new training topics.  We frequently collaborate with client Subject Matter 
Experts to develop new topics.  The “proof” that the AuthorMax solution 
works to rapidly develop and deploy emergent training topics is in the 
growing list of unique topics running at the MTF and Medical Center level. 
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Notes: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Examples of PerforMax3 Developed Content 
with Input from MTF and VAMC Subject-
Matter-Experts 

• USAF Medical Readiness Suite (6 courses for Andrews 
AFB) 

• Depleted Uranium (US Army) 
• Warfarin/Coumadin Education (2 courses for VA Erie) 
• Unauthorized Commitments and Ratifications 2009 

Training (VA Erie) 
• The Veteran as Patient (VISN 20) 
• Women Veterans 
• Suicide Prevention 

 
Our client-authors have distinguished themselves by quickly mastering the 
AuthorMax authoring tool and producing content for their local command to 
meet emergent training requirements.  One recent case in point, a hospital 
corpsman (HM2) learned AuthorMax and developed and deployed the 
following list of topics in 50 days as a part time developer. 
   
Examples of MTF authored content: 

• DOD Phishing Awareness 
• Performance Based Budgeting 
• Sponge Count Policy 
• Online Command Orientation for Civilians 
• Online Command Orientation for Military 
• Bio Ethics 
• Organ and Tissue Donation 
• AHLTA Contingency Plan 
• Basic ECG Recognition 
• Initial Security Indoctrination 
• Workers Compensation 
• Universal Protocol 
• No Fear Act 
• Breast Feeding – The Gold Standard 2009 
• Research at NNMC FY 2009 
• Discrimination and Harassment – Command Managed EEO 
• Drug Free Workplace 
• Hospital Corpsman – Basic Skills 
• Infant Security Training 
• Intrapartum Shoulder Dysocia 
• IV-Push Medications 
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Enable Rapid Courseware Development 
Notes: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notes: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

AuthorMax and the ToolBook Instructor application at its core facilitate 
rapid courseware deployment.  Our approach to content deployment is to 
repurpose and reuse learning objects rather than creating from scratch.  Up 
to 95 percent of the equity in existing courseware and templates is reusable.  
Reuse and repurposing high quality content that has been developed, tested 
and previously deployed ensures functionality and standards compliance 
while greatly simplifying the content developer’s job.  AuthorMax allows 
the content author to easily modify existing content and to create new 
content that maintains the look and feel of the PerforMax3 COTS 
Courseware. 
 

• Customize COTS Courseware rapidly, tailoring it to meet specific 
training requirements 

• Repurpose and reuse content and learning objects from 2000 pages 
of COTS courseware and templates to create new courses. 

• All learning within the COTS Courseware and AuthorMax 
templates are available for reuse in the creation of new content 
under the license for the courseware and authoring tool. 

• The AuthorMax/ToolBook graphical user interface creates an 
intuitive workspace for part time content developers who are not 
software developers by trade. 

• Drag and drop catalog objects, cut and paste page object, replicate 
and reuse pages from other courses, re-sequencing, adding and 
deleting pages are all intuitive tasks. 

• Import graphics and media from other sources.  
• Placeholder objects from the ToolBook catalog allow the use to 

directly reuse existing graphics and html pages. 
• MS Powerpoint import capability supports the import of Powerpoint 
• Directly access RTF and text document, link to existing PDF 

documents 
• In addition, ToolBook provides numerous wizards and other tools 

that facilitate rapid courseware development 
 

 

Feature Set and Learning Object Library 

The AuthorMax authoring tool with ToolBook Instructor 9.5 is a very 
powerful and robust application for the development of e-learning content 
and web-based training.  ToolBook has an extensive online catalog of 
learning objects, ready for use.  There are dozens of utilities, wizards and 
tools that expand the feature set and automate development functions.  The 
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application also includes the Action Editor, a graphical programming 
language used to create custom interactivity, branching and add event driven 
“action” to any learning object. 

Notes: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
• ToolBook’s Microsoft PowerPoint® support enables you to rapidly 

reuse PowerPoint content in your ToolBook authored course. This 
feature converts Microsoft PowerPoint content (PPT) to the 
ToolBook format. After conversion, the supported PowerPoint 
objects are fully editable within ToolBook – including text, images, 
and hyperlinks - where you can quickly enhance the imported 
presentation with assessments, interactivity, media, and rich effects. 

• ToolBook includes numerous assessment types - true/false, 
multiple-choice, drag and drop, match item, essay, and more - that 
can be used test and validate user understanding, create tests and 
interactive exercise. These objects have built-in functionality that 
provides feedback to the student why supplying “interaction 
information” and other tracking data via the SCORM API 

• ToolBook supports a comprehensive software simulation capability 
enabling the content author to simulate complex applications.  (See 
AHLTA Dental case study).  The Simulation AutoBuilder enables 
the author to record and latter edit a live application encounter.  
Screen shots and on screen events can them be used in simulation 
training 

• ToolBook placeholder object allow the developer to link to or 
include external learning resource directly in the content flow 
including documents, web/html pages, graphics.  Placeholder object 
also support the inclusion of other document type such as MS Excel 
spreadsheets and MS Word documents. 

• The learning object catalog includes over 250 learning object ready 
for drag and drop onto the content page.  This list includes the 
follow object types: Buttons, media players, navigation objects, 
placeholder objects, 13 questions types, 48 pre-made smart pages, 
scoring and tracking tools, draw objects, action and control objects, 
text fields, list boxes and simulation objects 

• The Action Editor provides a graphical programming interface to 
create code behind ToolBook objects.  This very powerful 
capability supports custom interactivity, branching and other 
dynamic, event-driven “actions” within the courseware.     

• Broad support for multi-media elements is support through catalog 
media players that support for all common media formats and 
graphical images. 

• Graphical/Image Support Images: bmp, cdr, ch3, dib, drw, dxf, eps, 
gif, jpg, pcd, pct, pcx, pic, png, tga, tif, wmf  
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Notes: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Audio Support: aa, aif, aifc, aiff, mid, midi, mp3, mp3 playlist, rmi, 
wav, streaming audio by Microsoft®, RealAudio™ or Apple 
QuickTime™  

• Video Support: avi, mov, mpg, streaming video by Microsoft®, 
RealVideo™ or Apple QuickTime™  

• Support for other media types: Macromedia Flash®, Windows® 
media files, RealMedia™ media files, asp, http 

• With new XML support, XML content can be quickly converted to 
the ToolBook format where it is now fully editable with the 
ToolBook applications. 

 
 

Compatibility and Interoperability 

The AuthorMax authoring tool with ToolBook Instructor 9.5 creates content 
that viewable in all the major web browser platforms without the need for 
plug-in or downloads.  AuthorMax content is easily integrated into SCORM 
2004 and SCORM 1.2 conformant LMS applications including MHS Learn 
platform (Oracle iLearning) and the VA LMS platform (Plateau Learning).  
AuthorMax content can also run in LMS systems that use the AICC 
protocol.  This high level of compatibility and interoperability ensure that 
the AuthorMax authoring tool can be used to address training requirements 
in virtually any environment. 
 

• Content integration across a wide variety of LMS platforms has 
been demonstrated including Plateau, SABA, Oracle, Pathlore, 
SumTotal, Knowledge Planet, Tracker.NET and virtually any other 
that support the top three learning standards SCORM and AICC 

• ToolBook catalog objects have built-in/automatic LMS 
communication features.  In addition, advanced settings are 
accessible were needed for unique or complex integration tasks 
using the Action Editor, virtually the entire SCORM/CMI 
vocabulary is available to AuthorMax content developers. 

• AuthorMax generated courseware supports and is compatible with 
Internet Explorer 6 and 7 and Mozilla/Firefox browsers.  The 
authoring tool also supports the Safari browser on Apple/Mac 
machines.   

• ToolBook/AuthorMax content can be designed for deployment on 
hand held devices and the Apple iPhone. 

• AuthorMax content has no Java Runtime dependencies, does not 
require browser plug-ins and is highly reliable running in the web 
environment 
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Notes: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Authoring Tool Maintenance 

AuthorMax support and maintenance plan is offered free to the government 
for the 24 months after initial contract award.  The authoring tool support 
and maintenance plan covers 105 licenses for 210 content authors. 
  
The support and maintenance plan for AuthorMax includes maintenance of 
software items as well as support for the license holders using the authoring 
tool.   
 
Software maintenance assures that the software itself including ToolBook 
Instructor 9.5, and the AuthorMax template will be maintained through all 
updates, patches and bug fixes during the period of performance. 
 
Software support provides unlimited email and phone support for the 
ToolBook Instructor 9.5 application and also for the AuthorMax template 
provided through the PerforMax3 help desk.  The support agreement entitles 
license holders to request assistance via phone or email when working with 
content derived from the AuthorMax template or from the COTS 
Courseware.  In addition, the license holder is entitled to unlimited support 
and assistance directly from SumTotal Systems Inc, producers of ToolBook 
Instructor.  This resource is useful in the event a bug is suspected or 
detected. 
 
In addition to the above support and maintenance for the ToolBook 
Instructor element of the AuthorMax author tool, the license holder is 
entitled to receive any “upgrades” to the ToolBook product during the 
period of performance of the agreement.  Upgrades typically occur 
when there is a major new release of the product providing additional 
functions, and features.  For example, ToolBook Version 9.5 recently 
replaced ToolBook 8.9 through as an “upgrade”.  The plan ensures 
that similar upgrades are available at no cost the government for the 
period of performance of this contract.  
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Notes: 
 
PerforMax3 lessons are 
pre-formatted and pre-
programmed to be 
easily customized to 
your application. 
 
 

Understanding the ToolBook 
Instructor Interface 

Getting Started 

PerforMax3 lessons are “pre-built” in SumTotal’s ToolBook as templates 
that contain key information and guidelines for a variety of training topics.  

Using ToolBook Instructor with the PerforMax3 templates, you will be 
able to:  

 Customize online lessons, 

 Add your own content,  

 Quickly create interactive questions and buttons, and  

 Import animations and graphics. 
 
 
Using ToolBook Instructor and the PerforMax3 system, you can focus 
on what is important: presenting the material to be learned.  
 
PerforMax3 preformatted templates help you manage the content, 
navigation, feedback, and quizzes that are a vital part of your interactive 
learning applications. You can easily add preprogrammed sound, 
animation, video, graphics, and other special effects to your applications, 
making them lively and engaging. Prebuilt hyperlinks and navigation 
objects allow your learners to move easily through their learning 
experience. 
 
After you have 
customized a lesson using 
ToolBook Instructor, 
PerforMax3 can help you 
deliver it on demand to 
any student with access to 
the Internet, or you can 
deploy it on your 
company’s intranet.  
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Notes: 
 
Working files are called 
books and have .tbk  
file extentions  
 
Backgrounds create a 
consistent theme 
throughout your book. 
 
 

Running the Editing Software 

Start ToolBook Instructor as you would any Windows application.   

 

 

 

The Startup dialog box appears and offers you several options to modify or 
start a new file called a book.. To help you quickly create interactive online 
lessons, PerforMax3 provides you with pre-programmed, pre-formatted 
lessons and templates. You can either open a pre-formatted template or 
copy an existing pre-programmed lesson to modify for new training. 

 
 
 

Existing Books  
 
 
 
 
 
 
 OK 
  
 
 
 

Opening a PerforMax3 Lesson or Template 
 
1. Select the Existing Books tab at the top of this box, and browse to 

the directory where your PerforMax3 lessons are located.  

2. Select one of the lesson files. 

3. Click OK in the Instructor dialog box to open the lesson. 
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Notes: 
 
Press the F3 Function 
key to toggle easily 
between Author and 
Reader levels. 
 
Author level for editing; 
Reader level for 
testing. 
 
 

Using Author Level and Reader Level 
Designed for ease of use, the ToolBook Instructor tools and visual interface 
let you focus on the important tasks of presenting your content and 
measuring student results. There are two working levels: Author level and 
Reader level. 

At Author level, you create and modify applications using authoring and 
development tools such as templates and dialog boxes. At this level, you can 
create and modify objects and set properties to define their appearance and 
behavior.  

Reader level is the level at which you test your applications as you develop 
them, and also the level at which users run your applications. At this level, 
users can navigate to particular pages, respond to interactive question 
objects, and trigger events.  

There are two ways to move between Author and Reader levels: 

• Press the F3 function key to toggle between Author and Reader levels. 
• From the View menu, choose Reader or Author. 

Author level with menu, 
and toolbar 

Reader level with working buttons 
and graphics 
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Notes: 
 
Press the F3 Function 
key to toggle easily 
between Author and 
Reader levels. 
 
Author level for editing; 
Reader level for 
testing. 
 
 

Author Level Tools 

Menu 

Like the Windows menu, most menu commands have familiar keyboard 
shortcuts such as Ctrl A, Ctrl C, and so on. View the Online Help for a 
list of all keyboard shortcuts. 

Toolbar  

The toolbar provides navigation buttons that help you move through 
the book when authoring. The other icons on the toolbar provide 
shortcuts for specific commands, such as document save and quick 
access to the properties of a selected object. 

Status Bar  
The Status bar displays the current page number and the mouse 
location. Move your mouse pointer over any object on a page and the 
status bar will identify the object and its location for you. 

Tool Palette 

The Tool Palette provides an easy menu to add shapes, buttons, and 
other functionality to your lesson. It can be turned on and off with the 
tool icon on the toolbar, and resized/repositioned using the cursor. 

 
Menu
Toolbar 

Tool 
Palette 

Status 
Bar 

 13



C U S T O M I Z I N G  P E R F O R M A X 3  C O U R S E W A R E  
U S I N G  A U T H O R M A X  

Notes: 
 
Press the F3 Function 
key to toggle easily 
between Author and 
Reader levels. 
 
Author level for editing; 
Reader level for 
testing. 
 

Coach  

The ToolBook Coach is a reference tool that provides information 
about the objects you select. It gives a description of the object as well 
as step-by-step procedures. To open the Coach, go to the Help menu 
and select Coach. 

Page  
The page is the area on which you develop your content by adding 
objects from the Catalog, such as buttons, text fields, and graphic 
placeholders. 

 
The following additional tools are available to turn on and off at 
Author level: 

Catalog  
The Catalog is a repository of objects you can add to your page, such as 
buttons, draw objects, and text fields. Many objects have pre-
programmed behavior that you can customize. 
 

Rulers  
Show the exact size and position of 
objects. 

Grid  
Displays a matrix of dots that help you 
size and position objects precisely. 

Right-Click Menus   

Appear when you right-click an object, 
providing quick access to common 
settings and dialog boxes. 
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Notes: 
 
Three basic 
backgrounds: 
· Content 
· Assessment 
· Utility 
 
All of the visual 
elements of your 
application such as 
buttons, text, graphics, 
and even pages and 
backgrounds are 
objects. Each object 
has a set of properties 
that define its 
appearance and 
behavior. 
 

Books and Pages 

PerforMax3 online courses consist of one or more files called books. In 
your online book, each screen is considered a separate page. Pages 
contain the objects that determine the look and behavior of your lesson  
inlcuding buttons, graphics, text, media players, and so on. You arrange 
the pages in any order that suits your material and then determine a way 
for your users to navigate through the pages. 

A background is the foundation for a page. Several pages can share one 
background, and a book can contain several backgrounds. Most 
PerforMax3 lessons use three backgrounds: 

One content background is used throughout the lesson to maintain a 
consistent look. Text, graphics, buttons and other objects, are then 
placed on the background to engage the user, assess the user’s 
proficiency and meet your training objectives. 

One assessment background standardizes the layout of test questions 
and to support mastery programming. 

One utility background sets apart utility pages from training materials. 

Objects and Properties 

All of the visual elements of your application—buttons, text, graphics, 
and even pages and backgrounds—are objects. Each object has a set of 
properties that define its appearance and behavior. A text field, for 
example, has properties such as fill color, font characteristics, width, and 
height that determine its color and size, and other properties such as text 
alignment and field type that define how it displays text and whether it 
allows users to enter data. Some objects have properties that determine 
more sophisticated capabilities. A media player, for example, has 
properties that control the player’s interactive functionality, such as 
which media file will play and how the file will play at Reader level.  
 
Properties may be viewed and changed via a pop up menu box. For 
more information, see the later section, “Customizing PerforMax 3 
Lessons” 
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Notes: 
 
All of the visual 
elements of your 
application—buttons, 
text, graphics, and 
even pages and 
backgrounds—are 
objects. Each object 
has a set of properties 
that define its 
appearance and 
behavior. 
 
Select Coach from the 
Help menu. 
 
To display the Catalog;:  
choose Catalog from 
the View menu, click 
the Catalog icon on the 
toolbar, or press F2. 

 

Using the Coach 

The ToolBook Coach is a quick, 
convenient reference tool that 
provides context-sensitive information 
as you are authoring.  

The Coach displays design guidance, 
tips, and suggestions about the page 
you’re working on, and step-by-step 
procedures for any object you select.  

Leave the Coach open as you work 
and note how the information in the 
Coach window changes dynamically as 
you move between object and page. 

Working with the Catalog 

PerforMax3 provides you with pre-programmed, 
consistently styled templates that include many types 
and styles of objects that you may need. You can also 
build additional features into pages using The Catalog.   

To display the Catalog;:  choose Catalog from the View 
menu, click the Catalog icon on the toolbar, or press 
F2. 

In the Catalog, there are question sets, media players, 
navigation panels, and other interactive objects, many 
with predefined behaviors that you can customize.  

To include an object in your application, simply drag it 
from the Catalog to your page or background. Then, set 
its properties or extended properties to further define 
its appearance and behavior. 
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Navigating Within Lessons Notes: 
 
 
Press the F3 Function 
key to toggle easily 
between Author and 
Reader levels. 
 
Author level for editing; 
Reader level for 
testing. 
 
 
 

Reader Level 

You can use the PerforMax3 navigation menu to move about the lesson 
several different ways:  

 
forward and backward using the arrow keys,  
 

jump to the Topic Page and select a topic area,  

 
return to page one or  
 
move straight to the Assessment. 

 PerforMax3 navigation bar 
 
Author Level 
You can move different ways when authoring a PerforMax3 lesson:  
 

 On the Menu bar, drop down the “Go” menu
 
 

 
On the Status Bar, move page by page using the arrow keys,  
or select the page text box and enter the new page number.  
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Notes: 
 
Navigate lessons in 
Reader Mode with the 
PerforMax3 navigation 
bar using the arrow 
keys, the Topic Page, 
the Assessmsnt button 
or the Return button to 
go to page 1. 
 
Navigate lessons in 
Author Mode using the 
Go to button on the 
Menu bar, the arrow 
keys and page number 
box on the Status bar , 
or the Book Explorer. 

Using Book Explorer 

The Book Explorer shows all pages and objects in an outline view. Using 
this interactive object browser, you can easily move around in the lesson, 
move pages, access properties, and manipulate objects.  

Select Book Explorer from the drop down View menu on the Menu, and 
the Book Explorer index appears. As you move your cursor over the page 
index, a small preview image of each page will pop up to help you identify 
the page you desire. Select that page and move there directly. 

 

 

 

 

 

 

 

 

 

 

 

 

 Lesson page with Book Explorer index open 
 

Navigating pages is just one of the functions of Book Explorer.  There are 
several more advanced features: 

• reorder pages using drag and drop 
• select an object in the main window (if visible) 
• move an object to a different layer using drag and drop 
• move an object into a group using drag and drop 

display properties and change options for an objec• t by right-clicking to 
show the shortcut menu 

Book Explorer replaces the Page Browser and Object Browser in earlier ToolBook releases. 
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Notes: 
 
All of the visual 
elements of your 
application—buttons, 
text, graphics, and 
even pages and 
backgrounds—are 
objects. Each object 
has a set of properties 
that define its 
appearance and 
behavior. 
 
To display the Properties 
Dialog Box, select the 
object and choose the 
properties  icon in the 
menu bar, or right click 
your mouse. 

Author level for editing; 
Reader level for 
testing. F3 to switch. 
 
 

Understanding Properties and 
Extended Properties for Objects 

 
Each object is governed by properties that customize its appearance and 
behavior in your lesson. You can access an object’s properties by 
selecting the object on the page or in Book Explorer, right clicking your 
mouse or opening the Properties or Extended Properties dialog box on 
the Menu. 

These dialog boxes allow you to set an object’s color, specify a graphic 
displayed on a button, identify the correct answers in a question object, 
control when a video plays, and much more. 

You can also use the Properties dialog box to specify behavior that 
extends beyond individual objects. For example, you can set properties 
for a page, a background, and a book. You can even access the 
“Properties for Lesson” dialog box to set scoring and logging options. 

Working with Properties 

The Properties dialog box features tabs that organize a detailed set of 
options. The toolbar includes buttons to give you quick access to 
commands, other object properties, and online Help.  

For example, selecting the Draw tab allows you to insert a caption for 
your button, change the color of the text, and change the look of the 
button via the Draw menu.  

 

 19
Properties dialog box showing
draw options 



C U S T O M I Z I N G  P E R F O R M A X 3  C O U R S E W A R E  
U S I N G  A U T H O R M A X  

Notes 
 
 
 
 
 
 
 

 

Extended Properties 
 

Some objects have extended properties that define preprogrammed 
behavior. In addition to the Properties dialog box, these objects have an 
Extended Properties dialog box, where you can specify and refine these 
extended capabilities. 

There are five ways to display the Extended Properties dialog box: 

1. Selecr the object, then choose Extended Properties from the 
drop down Object button on the Menu.  

 
2. Select the object, then click the Extended Properties icon on the 

Toolbar. 
 

3. Open the object’s Properties dialog box, and select the 
Extended Properties icon on the dialog box toolbar. 
 

4. Select the object, then choose the extended properties command 
from the right-click menu. 
 

5. With the object selected, press CTRL+F6. 
 
 
 
 

 
Extended Properties dialog box showing properties for an
Action Trigger 
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About the PerforMax3  Notes 
 
Adults learn best when 
the following elements 
are included in the 
learning: 
· Engage learners 
· Address thinking, 

feeling and acting 
· Use realistic 

examples 
· Vary learning 

methods 
· Use multisensory 

learning objects. 
 

Templates 
The PerforMax3 templates are prebuilt, preprogrammed pages in an 
organized book that provide a basic structure for your new lessons, 
including page organization, graphic theme, interactive objects, and 
navigation controls.  

 
 
 
Good instructional design is a combination of right brain/left brain 
thinking.  Right brain involves creative thinking. Left brain involves 
analytical thinking. 
 
In computer-based training development, the combination of a 
consistent background, various media elements (graphics, photos, video 
clips, audio, etc.) and factually accurate content or text can make or 
break a learning program. 

The PerforMax3 template book provides a structure that is effective, 
efficient, and maintains consistent functionality that builds a learner’s 
confidence and speed. Learners can focus on your content, and not 
waste time trying to understand changing navigation and interaction 
procedures. 
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You can copy objects or pages from the PerforMax3 template book into 
your existing lessons to take advantage of a variety of interactive features 
without the trouble of creating programming and formatting. For step-
by-step instructions, see “Adding, Deleting and Renumbering Pages” in 
the Customizing PerforMax3 Lessons section. 

Notes 
 
PerforMax3 provides 
pre-programmed 
templates for all page 
designs. 
 
Adults learn best 
when the following 
elements are 
included in the 
learning: 
· Engage learners 
· Address thinking, 

feeling and acting 
· Use realistic 

examples 
· Vary learning 

methods 
· Use multisensory 

learning objects. 
 

 

Using PerforMax3template pages and books will save time, ensure 
capability, and provide consistency for each new lesson. 
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Notes 
 
PerforMax3 provides 
pre-programmed 
templates for all page 
designs. 
 
Adults learn best 
when the following 
elements are 
included in the 
learning: 
· Engage learners 
· Address thinking, 

feeling and acting 
· Use realistic 

examples 
· Vary learning 

methods 
· Use multisensory 

learning objects. 
 

Key Features of the Template Book  

Preformatted Standard Pages and Functions 

• Title Page 
• Overview Page linked to Learning Objectives Page 
• Test Out Option Page hyperlinked to Assessment Instructions 
• Topic Page hyperlinked to key topics 
• Menu Tabs 
• Assessment Instructions 
• Assessment Questions  
• About Page for recording revision changes 
• Learner Scoring 

Preprogrammed Interactive Pages 

• Numerical, Bulleted and Timed-Display Lists 
• Self-Check Questions and Answers 
• Multiple Choice Selections 
• True or False Responses 
• Concept to Definition Matching 
• Various Graphic Buttons 
• Hide and Reveal Functions for Text and Graphics 
• Video Windows 
• Drag and Drop Interaction 
• Small Scale Animation  
• Light Bulb “Did you know?” button 
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U S I N G  A U T H O R M A X  

Notes 
 
PerforMax3 provides 
pre-programmed 
templates for all page 
designs. 
 
Adults learn best when 
the following elements 
are included in the 
learning: 
· Engage learners 
· Address thinking, 

feeling and acting 
· Use realistic 

examples 
· Vary learning 

methods 
· Use multisensory 

learning objects. 
 
All of the visual 
elements of your 
application—buttons, 
text, graphics, and 
even pages and 
backgrounds—are 
objects. Each object 
has a set of properties 
that define its 
appearance and 
behavior. 
 

Preformatted Standard Pages 

The PerforMax3 templates are preformatted with a generic background, 
standard title type, size and placement, page navigation and a navigation 
menu bar at the top. Each feature can be customized to suit your 
organization and lesson Refer to the section, “Customizing PerforMax3 
Lessons.” 

 

 

 

 

 

 

Navigation 
menu 

Title and text 
blocks 

 
Standard Parts of a Lesson Page 

 

The standard Overview page provides title styling and position, a sample 
graphic placeholder, a text box with type styling and page navigation.  

This page acts as an “Advanced Organizer” and allows the learner to 
anticipate what’s ahead. 

 
 

 

 

 

 

 

Objectives Page 
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In addition, this template page includes the Learning Objectives button 
that brings up the standard Learning Objectives template. 

Notes 
 
PerforMax3 provides 
pre-programmed 
templates for all page 
designs. 
 
Adults learn best when 
the following elements 
are included in the 
learning: 
· Engage learners 
· Address thinking, 

feeling and acting 
· Use realistic 

examples 
· Vary learning 

methods 
· Use multisensory 

learning objects. 
 
All of the visual 
elements of your 
application—buttons, 
text, graphics, and 
even pages and 
backgrounds—are 
objects. Each object 
has a set of properties 
that define its 
appearance and 
behavior. 
 

 
 

 

 

 

 

 

 

 

Select the “Learning 
Objectives” button 
to reveal Learning 
Objectives 

Next, the Navigation Bar offers a direct link to the Assessment section 
for those learners who may not need review.  

 

 

 

 

 

 

 

 Select this icon to bypass the content and 
go directly to the assessment 
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A comprehensive sample of interactive pages is offered to help you keep 
the learner engaged and to build retention through interesting review 
and self assessment.  

Notes 
 
PerforMax3 provides 
pre-programmed 
templates for all page 
designs. 
 
Adults learn best when 
the following elements 
are included in the 
learning: 
· Engage learners 
· Address thinking, 

feeling and acting 
· Use realistic 

examples 
· Vary learning 

methods 
· Use multisensory 

learning objects. 
 
All of the visual 
elements of your 
application—buttons, 
text, graphics, and 
even pages and 
backgrounds—are 
objects. Each object 
has a set of properties 
that define its 
appearance and 
behavior. 
 

Adult learners like to control their training, and this interactivity 
provides an environment of choice and affirmation that helps with 
lesson retention. 

 

 

 
 
 
 
 
 
 
 

Graphic Buttons Link to Specific Information 

Self Checks Engage Learners 
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U S I N G  A U T H O R M A X  

The Topic Page template, accessed from the tab menu, provides quick 
navigation to key areas of information, and an option for jumping to the 
Assessment if the learner feels confident in the lesson.  

Notes 
 
PerforMax3 provides 
pre-programmed 
templates for all page 
designs. 
 
Adults learn best when 
the following elements 
are included in the 
learning: 
· Engage learners 
· Address thinking, 

feeling and acting 
· Use realistic 

examples 
· Vary learning 

methods 
· Use multisensory 

learning objects. 
 
All of the visual 
elements of your 
application—buttons, 
text, graphics, and 
even pages and 
backgrounds—are 
objects. Each object 
has a set of properties 
that define its 
appearance and 
behavior. 
 

 

 

 

 

 

 

 

 
Topic Menu Provides Quick Access to Key Points 

 

 

 

 

 

 

 

 

 
Standard Introduction to Training Assessment 

 
PerforMax3 provides a standard Assessment Instruction template that 
can be used as is.  In addition, two styles of assessment questions, 
True/False and Multiple Choice, are customizable and ready to 
duplicate. Tracking, scoring and resetting functions are all 
preprogrammed.
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 Notes 
 
PerforMax3 provides 
pre-programmed 
templates for all page 
designs. 
 
Adults learn best when 
the following elements 
are included in the 
learning: 
· Engage learners 
· Address thinking, 

feeling and acting 
· Use realistic 

examples 
· Vary learning 

methods 
· Use multisensory 

learning objects. 
 
The training 
assessment is one of 
the most complicated 
parts of the PerforMax3 
template.  It is critical 
that you use the 
processes and 
conventions outlined in 
the “Customizing the 
PerforMax3 
Assessment” section of 
this document. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Above: Sample True/False Assessment Question 

Below: Sample Multiple Choice Question 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

 

 
 
 
 
 
 

The training assessment is one of the most complicated parts of the
PerforMax3 template.  It is critical that you use the processes and 
conventions outlined in the “Customizing the PerforMax3 
Assessment” section of this document. A considerable amount of 
hidden software code behind the training assessment controls 
behaviors, scoring and data management.  
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